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Introduction 
 

General Data Protection Regulation (GDPR) became enforceable on May 25, 

2018. CareFree Management Ltd has made changes to meet all the necessary 

requirements and we are here to help you meet them too.  

This guide will inform you of the capabilities our system has in terms of storing 

personal data; It will cover your staff, your clients, finance and user security. In 

the main, the guide will focus on personal data. This is information that relates 

to a natural person or data subject which allows them to be identified directly 

or indirectly. For example, a name, ID number, IP address or health information.  

The guide will intend to help you minimise the risk of a personal data breach. A 

breach can happen to any company that’s transmitted, stored or otherwise 

processed data. A personal data breach can be defined as a breach of security 

which leads to:  

1. Access of personal data  

2. Unlawful destruction of personal data  

3. Loss of personal data  

4. Change of personal data  

5. Unauthorised disclosure of personal data.  

Recommend ended retentions periods can be guided by the following link to 

the ICO governing body. The ICO has provided a number of resources relating 

to legalities for the health and social care sector. You may decide to enforce 

different retention periods based on your own company policies.   

The link to the website is as follows:  

https://ico.org.uk/for-organisations/in-your-sector/health/ 

https://ico.org.uk/for-organisations/guide-to-data-protection/guide-to-the-

general-data-protection-regulation-gdpr/ 

We hope you find this guide a useful resource however if you have any further 

questions, please get in touch.  

  

https://ico.org.uk/for-organisations/in-your-sector/health/
https://ico.org.uk/for-organisations/guide-to-data-protection/guide-to-the-general-data-protection-regulation-gdpr/
https://ico.org.uk/for-organisations/guide-to-data-protection/guide-to-the-general-data-protection-regulation-gdpr/
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Personal Information in CareFree 
Personal information is held in numerous screens within CareFree. The next 

sections of this guide will explain where to hold information for a candidate in 

recruitment, an employee, a client, a customer/contract, client/customer 

invoices and wages. 

A consent form is recommended to gain permission for the company to store 

personal information which will inform why it is needed and who has access. 

GDPR states that the individual has the right to be forgotten as well as 

updated. The following sections will demonstrate functionality within CareFree 

and how this can be achieved. In terms of how long to retain each part of 

information, you should refer to the ICO website links on page 4 for guidance. 

Recruitment 
CareFree has the ability to hold information about a candidate in recruitment. 

The next sections are recommendations of what we would expect a company 

to hold for recruitment purposes. This information in held in the Carer screen. 

General Tab 
The general tab will store most general information about the candidate. 

 

1 The candidate’s full name is stored is the Surname and Forename fields 

2 The Address and Postcode is stored here 

3 The Date of Birth is stored here 

4 The National Insurance Number is stored here (if required) 

5 The Email Address is stored here 

6 The Gender is stored here 

7 Contact Numbers are stored in these fields 

1 

2 

3 

5 

6 

7 

4 
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Attachments Tab 
The attachments tab can be used to store any documentation for a candidate. 

All application forms and interview notes are can be stored here for 

unsuccessful candidates in this tab.  

In terms of how long to retain each part of information, you should refer to the 

ICO website links on page 4 for guidance but the following information 

demonstrates how to edit the information. 

1. In the Carer screen, go to the Attachments tab 

2. Click Edit 

3. Right-click in the blank area on the attachments 

screen and click New 

4. Use the file explorer to find the document to attach 

a. If CareFree is hosted use the Network section to search for the 

company shared drive or local PC  

 

5. Once the document has been attached 

CareFree will ask for an attachment name 

 

6. Click OK to save the attachments into the record 

 

  

If an attachment is added from a shared drive this will allow other users access to the 

attachments. Please ensure that the other users trying to access the attachments have 

the shared drive mapped on their computer. 
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Removing Unsuccessful Candidates   
Once the retention period has been reached, it is important to remove any 

personal information for any candidates who are unsuccessful with their 

application.  

 

1. Open the Carer screen 

2. Go to the candidate that requires deletion 

3. Press Delete at the bottom of the screen 

 

4.  To confirm deletion, press Yes 

The candidate will no longer be shown in any of the active, inactive, on hold or 

all lists. 

All information entered in the general tab and the attachments tab will be 

removed from the CareFree system. 

 

  

If the attachments were added from a shared drive the documents will need removing 

the shared drive as well 
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Employees and Client Information 
Employee and Client personal information can also be stored in the Carer or 

Client screen. There are several areas where information can be stored within 

CareFree.  

 

Client Screen   
The Client screen can hold various information about a client receiving care. 

A consent form is recommended to gain permission from the client for the 

company to store their personal information.   

To go to the Client screen, click Clients at the top of the CareFree main screen.  

 

General Tab 

 
 

1 The name of the client is stored is the Surname and Forename fields 

2 The Address and Postcode are stored here 

3 The Date of Birth is stored here 

4 The Gender is stored here 

5 Also Known As can be used to store a nickname for the client 

6 Contact Numbers are stored in these fields 

1 

2 

3 

4 

5 

6 
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Carer Screen   

 
The Carer screen can hold various information about themselves and their 

employment. 

A consent form is recommended to gain permission from the carer for the 

company to store their personal information.   

 

General Tab 
The general tab will store most general information about the carer. 

 

 

  

1 The Carers full name is stored is the Surname and Forename fields 

2 The Address and Postcode is stored here 

3 The Date of Birth is stored here 

4 The National Insurance Number is stored here (if required) 

5 The Email Address is stored here 

6 The Gender is stored here 

7 Contact Numbers are stored in these fields 

1 

2 

3 

5 

6 

7 

4 
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Attachments Tab 
As well as the documentation for candidates in the recruitment stage we 

would also expect a company to hold additional documentation for employees:  

• Pension Scheme Investment Policies 

• Personnel Files and Training Records (including disciplinary records and working time 
records) 

• Redundancy Details, Calculations of Payments, Refunds, Notification to The Secretary 
of State 

• Senior Executives' Records (that is, those on a senior management team or their 
equivalents) 

• Time Cards 

• Trade Union Agreements 

• Records Relating to Children and Young Adults 

• Retirement Benefits Schemes – Records of Notifiable Events, For Example, Relating to 
Incapacity 

• Working Time Records 

• Statutory Maternity Pay Records, Calculations, Certificates (Mat B1s) or Other 
Medical Evidence 

• National Minimum Wage Records 

In terms of how long to retain each part of information, you should refer to the 

ICO website links on page 4 for guidance but the following information 

demonstrates how to edit the information. 

1. In the Carer / Client screen, go to the Attachments tab 

2. Click Edit 

3. Right-click in the blank area on the attachments screen and click New 

4. Use the file explorer to find the document to attach 

If CareFree is hosted use the Network section to search for the company 

shared drive or local PC  

5. Once the document has been attached CareFree will ask for an 

attachment name 

6. Click OK to save the attachments into the record 

If an attachment is added from a shared drive this will allow other users access to the 

attachments. Please ensure that the other users trying to access the attachments have 

the shared drive mapped on their computer. 
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Logs Tab 
Contact logs can be used as an audit trail for conversations/incidents. It is 

important to record any important conversations or incidents between a 

member of staff, a customer, a client etc. In terms of how long to retain each 

part of information, you should refer to the ICO website links on page 4 for 

guidance but the following information demonstrates how to edit the 

information.  

1. Open the Carer / Client screen and click Edit 

2. Right-click the blank area in the Log screen and click New 

 

 

1 Fill in the Caller of the log 

2 Select the correct log Type and Category from the drop-down lists – this will help find the log in 
future searches 

3 An Alternative Date can be specified if a message is taken when a user does not have access to 
CareFree 

4 Choose the Status of the log i.e. open or closed 

5 Selecting a Client and/or Carer name in these drop-down boxes will show the log in their records 

6 Use these fields to enter Details, an Outcome and Lessons Learned 

7 Attachments can be added to the log here. Click the paper icon to add an attachment to the log 

8 Click Save to save the log to CareFree 

 

1 

2 

3 
4 

5 

6 

7 

8 
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Away Periods / Planner 
Away periods are entered on the CareFree rota. They can then be viewed on a 

yearly planner in the Planner tab in Carer’s record. This is a good tool to 

support absence monitoring, annual leave and parental leave requests. In 

terms of how long to retain each part of information, you should refer to the 

ICO website links on page 4 for guidance but the following information 

demonstrates how to edit the information.  

1. Open the Rota and the Carer or Client rota view 

2. Open the Away Periods tab at the bottom of the rota 

3. Click the  button at the top-right of the screen 

 

 

  

1 Select the date range of the away period using the From Date and To Date options 

2 Select the Start Time and End Time that the Carer / Client is away 

3 If the away period is annual leave, enter how many days annual leave they are using in the Taken 
Now field 

4 Use the Reason drop-down box to enter why they are away 

1 
2 

3 

4 
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Wages / Invoices Tab 
When finalising wages for employee’s the individual wage sheets are stored in 

the wages tab in the Carer’s screen. It is important for a company to keep 

information such as: 

 

• Wage/salary records (also overtime, bonuses, expenses) 

• Income tax and NI returns, income tax records and correspondence with 

HMRC 

 

Depending on how the company uses CareFree, some of the above may be 

stored in the Attachments tab of the Carer’s record. 

 

You should refer to the ICO website links on page 4 for guidance but the 

following information demonstrates how to edit the information.  

 

Invoices and Wage Sheets are stored in CareFree when they are finalised. Once 

finalised the invoice/wage sheet is stored in numerous screens. It is important 

to understand where the invoices/wage sheets are stored and how to remove 

them from CareFree after the recommended retention period has been 

reached.  
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Invoices 
Invoices are stored in the Invoices tab. Depending on who is paying for the 

invoice it will appear in: 

• Client records 

• Contracts 

• Customers 

 

All Invoices will appear in the 

Browse Invoices screen: 

1. Go to Tools 

2. Go to Invoices and 

Wages 

3. Click Browse Invoices 

4. Use the date ranges at the top of the 

screen to find the correct invoice 

 

Wage Sheets 
Wages are stored in the Wages tab in the Carer’s record. However, all wages 

will appear in the Browse 

Wage Sheets screen: 

1. Go to Tools 

2. Go to Invoices and 

Wages 

3. Click Browse Wage 

Sheets 

4. Use the date ranges at the top of the 

screen to find the correct wage sheet 
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Contracts Tab 
A contract is the agreement(s) in place for who is paying for the Client’s care. 

This information is stored in the Contracts tab in the Client’s record. 

The contract may be a private contract where the Client’s personal information 

will be stored or it may be a social services/council contract which may cover 

multiple Client’s care at the company. 

CareFree has the ability to hold information about a contract. The information 

listed below are all recommendations of what we would expect a company to 

hold for billing purposes. This information in held in the Contracts screen. 

 

 

 

 

  

1 The Contract Name is stored here, if this is a private contract it would usually be the name of the 
client/customer 

2 The Customer is stored here (person paying the bill) 

3 The Customer Address is stored in this tab – contact numbers and email are also stored in this tab 

4 Finalised Invoices for the contract are stored in this tab 

5 Logs for the contract are stored here  

6 The Clients that use this contract are stored here 

1 

2 

3 4 5 6 
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Customers 
A customer must be linked to a contract, whether this contract be private, 

social services, direct payments etc. Sometimes the customer will be an 

individual and sometimes an organisation. In the contracts screen, click the 

magnifying glass next to the customer field.  

 

 

 

 

 

  

1 The Customer Name is stored here. The customer name field would be if the customer was an 
organisation, for an individual fill in the Surname/Forename fields 

2 The Contact Name is stored here – if the customer is an organisation an individual contact can be 
stored here 

3 The Customer Address is stored in this tab – contact numbers and email are also stored in this tab 

4 Notes are stored here 

5 Finalised Invoices for the contract are stored in this tab 

6 Logs for the contract are stored here 

7 The Contracts that use this customer are stored here 

1 

2 

3 4 5 6 7 
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Removing an Employee/Client 
Due to CareFree collating various elements of personal information in different 

screens, the method for removing an employee or client should be followed in 

versions V5.5 or below. This is to ensure that the rotas, invoices, calls, logs, 

audit trails etc are not compromised. 

 

Instead, it is recommended that the records are made inactive. It is still 

important to ensure all relevant personal information is held for the 

recommended retention period and all irrelevant personal information is 

removed.  

 

1. Open the Carer/Client screen and open the appropriate record 

2. Open the Other Details tab 

3. Click Edit 

4. Change the Estimated End Date to the date the Carer is leaving the 

company or the date the Client is no longer receiving care 

 

 

 

5. Click OK to make the record inactive 
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As the Customer name/surname field is mandatory for a customer it is recommended that a 

reference number is stored in this field i.e. CareFree database reference number 

De-activating a Customer 
1. In the Contracts screen, go to the appropriate contract 

2. Click the magnifying glass next the Customer field 

 

 

 

3. Click Edit 

4. Change the Status drop-down box to 

Inactive 

 

Click OK for the customer to be moved into the inactive tab. Before doing so, 

we recommend that additional information is changed/removed from the 

customer while making them inactive: 

• Customer Name or Surname/Forename 

• Address and Postcode 

• Email 

• Contact Numbers 

• Invoices – see page 21 on how to unfinalise invoices 
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As the Customer name/surname field is mandatory for a customer it is recommended that a 

reference number is stored in this field i.e. CareFree database reference number 

De-activating a Contract 
1. In the Contracts screen, go to the appropriate contract 

2. Click Edit 

3. Change the Estimated End Date to the date the contract is finishing  

 

 

 

Click OK for the contract to be moved into the inactive tab. Before doing so, we 

recommend that the Contract Name is removed from the contract while 

making them inactive. 
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If any fields are mandatory in CareFree it is recommended that a reference number for the 

record is stored in this field i.e. payroll number, database ID 

Other Areas to Consider  
After the recommended retention period(s) companies should remove all 

information from CareFree from numerous tabs in a record. The areas you may 

need to review are as follows:  

 

General Tab 
Once the retention period is met, remove all personal information from the 

following fields: 

• Surname and Forename 

• Address and Postcode 

• National Insurance Number 

• Email 

• Gender 

• Contact Numbers 

• Also Known As 
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Unfinalising Invoices/Wage Sheets 
Invoices and Wage Sheets can be unfinalised either from the Clients/Carers 

Invoices/Wages tab or through the Browse Invoices/Browse Wage Sheets 

screen. 

 

1. Tick the Invoices/Wage Sheets 

that require unfinalising 

2. Right-click  

3. Click Unfinalise  

4. Click Yes to confirm the action 

 

 

Security Tab (for Carers) 
Remove all personal information past recommended retention including: 

• DBS disclosure numbers along with any notes 

• ISA information along with any notes 

• Workflows along with any notes 

 

1. Open the Carer screen 

2. Go to the Security Tab 

3. Click Edit 

4. Delete all personal 

information 

5. Click OK 
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Log Tab 
All logs relating to the Carer/Client may need reviewing. Some logs may need 

to be kept until a recommended retention period, please see the link on page 4 

for guidance.  

1. Go the Carer/Client/Customer/Contract screen then go to the Log tab 

2. Right-click the log and click Delete to delete the log from CareFree 

 

 

Attachments Tab 
Any attachments relating to the Carer can be reviewed for deletion.  

1. In the Carer screen, go to the Attachments tab 

2. Click Edit 

3. Right-click the attachment that requires deletion 

4. Click OK 
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Extras 
In this tab, remove all personal information from these fields.  

1. Open the Carer screen 

2. Go to the Extras Tab 

3. Click Edit 

4. Delete all personal 

information 

5. Click OK 

 

 

 

 

Planner (for Carers) 
The planner screen will display selected away periods for a Carer. Some away 

periods may need to be kept until a recommended retention period for 

example parental leave. Please see the links on page 4 for more information. 

At the end of the retention period it is important to remove the necessary 

away periods from CareFree. 

1. Go to the Rota 

2. Ensure the Carer’s rota is displayed 

3. Go to the Away Periods tab at the bottom of 

the rota  

4. Use the month selection to the left to quickly search through previous 

years of away periods, select the away period that required deletion 

5. Once the correct away period is selected, click the  button 

6. Click Yes to confirm deletion of the away periods 
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Payroll (for Carers) 
You should remove any bank details that may be stored in this tab. 

 

1. Open the Carer screen 

2. Go to the Payroll Tab 

3. Click Edit 

4. Delete all banking 

information from the 

Bank Details section 

5. Click OK 

 

Contacts 
The contact will need deleting from the contacts screen also, unless the 

contact is recorded on another Carer record i.e. a doctor. 

1. Open the Carer screen 

2. Go to the appropriate Carer 

3. Go to the Contacts tab 

4. Click Edit 

5. Right-click the contact and press Delete 

6. Click OK to save 

If the contact needs removing from the contacts screen: 

1. Go to View 

2. Click Contacts 

3. Using the drop-down box at the top left-hand side of the screen go to 

the category that the contact falls under 

4. Select the appropriate contact and click Delete 

5. Click Yes to confirm deletion 



 

 

25 

User Security 

It is important that all users that need to access CareFree have their own user 

account. The CareFree audit trail will keep track of all user actions therefore 

making the audit trail a reliable tool when investigating if all staff are logging in 

with their own user account.  

User Roles 
Administrators are able to personalise what access each user has and which 

branch they work with. This will limit what data can be seen by each user. User 

roles are created/amended via the Items screen choosing the functionality 

each user role has access to.  

1. Go to the Items screen  

2. Go to User Roles 

3. Click New to create a new user role or to amend an existing user role, 

select the user role and click Edit 

 

4. A list of system areas will be displayed. The tick boxes within these areas 

will allow permission where ticked and deny when unticked e.g. under 

the Carers area if the Add tick box is ticked the user will be able to add 

new carers to CareFree. If the Delete tick box is unticked the delete 

button will be greyed out 

Once the roles and role restrictions/access criteria have been set users can be 

created and assign to the appropriate user role. 
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Financial Information User Access 

It is common for system administrators and managers to want to restrict 

access to financially sensitive information.  This is easily achieved by denying 

access to certain functional areas for specific user roles.  

 

 

 

 

To restrict access to the wages 

or invoices sections ensure 

that there are no ticks in the 

access rights for the areas of 

Invoices & Wage Sheets 

 

It may be handy to also restrict 

access to pay and charge rules as 

this will display hourly pay rates 

 

 

To restrict users being able 

to access finance information 

such as bank details ensure 

the tick boxes in the finance 

section are unticked 
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Adding Users 
1. Go to the Tools menu at the 

top of the screen 

2. Go to Maintain Users 

3. Click Users 

4. When the user screen 

appears, click New to create a new user 

 

5. Type in the name of the required new user in the User Name field 

6. Select an appropriate role for the new user 

7. Select the companies and branches this new user will have access to 

8. Select whether the new user will need to receive alerts and/or 

notifications for certain companies and branches 

9. Click OK and to save the new user 
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Logging in as a Different User 
It is essential that you are always logged into CareFree with your own user 

account.  

A quick way to see who is logged into CareFree is by looking to the bottom left 

hand part of the screen which will show the name of the user who is logged in 

and what their user role is.  

 

If the user who is logged in is not your user account you must switch users.  

1. Go to the File menu at the top of the 

screen 

2. Click Log in as a different user… 

 

 

3. Enter in your own User name along 

with your Password 

4. Click OK 
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Password Security 
It is important to ensure all users keep their password secure and ensure all 

users have a password that only they know. The CareFree audit trail will keep 

track of all user actions therefore making the audit trail a reliable tool when 

investigating if all passwords are kept secure. 

Resetting and Changing Passwords 
By default, the password for a new user is set up as being the same as their 

user name.  

This can be altered using the passwords screen.  To access this screen: 

1. Go to the Tools menu at the 

top of the screen 

2. Go to Maintain Users 

3. Click Passwords 

 

4. The passwords screen will then appear 

 

5. Select the user whose password you wish to change 

6. Type new password in the New Password field 

7. Click Change to change the user’s password 

8. By clicking Reset this will change the user’s password to the default 

setting (their username) 
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Changing Your Own Password 
Users have the ability to change their own password if required to do so.  

If CareFree does not ask for passwords to be changed on a regular basis our 

recommended is for users to change their own password every 30 days or 

when they feel it is necessary to do so. This ensures that staff are accessing 

CareFree under their own user account and not logging in as somebody else. 

 

1. Go to Tools 

2. Click Change your own password… 

 

3. Users must enter their Old Password to begin with 

 

4. Users must then enter a New Password and confirm the new password 

5. Click Change once completed 
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Password Security – Shared Options 
A setting for all users can be set within the shared options of CareFree to 

ensure passwords are reset after a certain amount of days and a minimum 

amount of characters are used on every password. 

Our recommendations for these settings are below. 

1.  Go to the Tools menu at 

the top of the screen 

2. Go to Options and Settings 

3. Click Shared Options 

4. When the shared options screen appears, click Security listed down the 

left of the screen 

 

 

  

1 ‘Allow re-use of password’ will determine whether users can use a previously used password to 
access CareFree 
Our recommendation is that this option is switched OFF 

2 ‘Force change of passwords when reset’ will force the user to change their password when it has 
been reset 
Our recommendation is that this option is switched ON 

3 ‘Minimum character for passwords’ will determine the number of characters that must be used for 
a password 
Our recommendation is that this option is set to 8 

4 ‘Days before passwords expire’ will determine the number of days before a password will need to 
be changed 
Our recommendation is that this option is set to 30 

1 

2 3 

4 
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Glossary 
 

Additional Training Guides 
 

Day 1 Training Guide – This guide will explain the basics of CareFree and is 

recommended to be read by users who are new to CareFree.  

 

Day 2 Training Guide – This guide will explain the advanced features of 

CareFree. It is based on the user having basic knowledge of CareFree.  

 

Day 3 Training Guide – This guide will explain how to set up the financials in 

CareFree. The guide ranges from setting up charge rates for clients and pay 

rates for Carers. The guide will also explain how to run invoices and wages. It is 

based on the user having basic knowledge of CareFree.  

 

CareFree Knowledge Base – The knowledge base, also known as the DokuWiki, 

is updated regularly by the CareFree training team and is useful to refer to as 

quick training guide 

http://knowledge.homecaresoftware.co.uk/lib/exe/fetch.php?media=wiki:training_booklet_-_carefree_v5.5_day_1_training_v2.pdf
http://knowledge.homecaresoftware.co.uk/lib/exe/fetch.php?media=wiki:training_booklet_-_carefree_v5.5_day_2_training_v1.pdf
http://knowledge.homecaresoftware.co.uk/lib/exe/fetch.php?media=wiki:training_booklet_-_carefree_v5.5_day_3_training_v1.pdf
http://knowledge.homecaresoftware.co.uk/doku.php?id=start

